
  HRD Software LLC 
 

2013 

HRD Logbook 
Ham Radio Deluxe V 6.0 
Tim Browning (KB3NPH) 

 



1 

Table of Contents 
Introduction .................................................................................................................................... 3 

Getting Started ................................................................................................................................ 4 

Importing Previous Log Data....................................................................................................... 5 

Supported Databases ...................................................................................................................... 7 

Access Database .......................................................................................................................... 7 

MySQL ......................................................................................................................................... 7 

Microsoft SQL Server Express ..................................................................................................... 7 

Creating A New Access Database ................................................................................................... 8 

Creating A New MySQL Database ................................................................................................. 10 

Callsign Lookup ............................................................................................................................. 29 

LoTW and eQSL.cc Support ........................................................................................................... 32 

Setting Up eQSL ........................................................................................................................ 32 

Uploading to eQSL.cc ............................................................................................................ 33 

Setting Up LoTW ....................................................................................................................... 36 

Requesting Your Certificate .................................................................................................. 36 

Uploading to LoTW ............................................................................................................... 43 

Downloading QSLs .................................................................................................................... 45 

Downloading From eQSL ...................................................................................................... 45 

Downloading From LoTW ..................................................................................................... 47 

Creating Logbook Layouts ............................................................................................................. 49 

Printing A Hard Copy ..................................................................................................................... 52 

Menu Options ............................................................................................................................... 54 

File ............................................................................................................................................. 54 

View .......................................................................................................................................... 54 

Calendar .................................................................................................................................... 54 

Countries ................................................................................................................................... 54 

Logbook ..................................................................................................................................... 54 

Tools .......................................................................................................................................... 54 

Main Toolbar ................................................................................................................................. 54 

Removing Main Toolbar ............................................................................................................ 55 

Logbook Icons ............................................................................................................................... 55 

Add Log Entry (ALE) ....................................................................................................................... 57 

 



2 

Contest ALE ................................................................................................................................... 58 

Logbook Backups .......................................................................................................................... 59 

Automatic Backup Locations ..................................................................................................... 59 

Manual Backups ........................................................................................................................ 60 

Restoring Backups ..................................................................................................................... 61 

Export/Import Logs ....................................................................................................................... 61 

Exporting an ADIF File ............................................................................................................... 61 

Exporting a Cabrillo File ............................................................................................................ 62 

Exporting an Excel XML file ....................................................................................................... 62 

Importing Logs .......................................................................................................................... 63 

Bulk Editor ..................................................................................................................................... 65 

HRDLog.net ................................................................................................................................... 65 

DX Cluster ...................................................................................................................................... 67 

Ham Radio Deluxe and The DX Cluster ..................................................................................... 69 

Using CC User as a DX Spot Pre-filter for HRD .......................................................................... 69 

Basic DX Spot Filtering .............................................................................................................. 72 

Awards Tracking ............................................................................................................................ 76 

Label Printing ................................................................................................................................ 77 

 

 

 

 

 

 

 

 

 

 

 



3 

Introduction 
HRD Logbook is the most popular feature of the Ham Radio Deluxe suite of programs.  The 
logbook can be used as a Stand-Alone program or is better used as part of the entire suite. 

The main features are:  
Logbook uses ODBC which in turn provides support for Access, MySQL and Microsoft SQL 
Server.  

Display an unlimited number of databases simultaneously.  

It provides full diagnostics in the logfile. 
 
Other features include automatic or manual log backups, export logs in various formats including 
ADIF 2, ADIF 3 (ADX), Cabrillo, and Excel XML formats. 
 
Automated callsign lookup is accomplished from QRZ via XML subscription and QRZ CD,  
Hamcall CD and Hamcall.com Subscription, RAC CD, SAM CD, Callook.info which is a FREE 
on-line call lookup service. 
 
HRD Logbook also provides full upload and download capabilities for eQSL.cc, LoTW, and 
HRDLog.net (not associated with HRD Software LLC) 
 
Starting with Version 6.0, contest logging has been added along with completely re-written 
Awards Tracking and DX Cluster support. 
 
All in all, HRD Logbook is the most powerful logging software on the market today. 
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Getting Started 
If this is the first time you have used HRD Logbook, there are a couple things we need to start 
with.   

First, if you have been using another logging program and are worried about losing all those 
contacts, you don’t have to be.  If the other software you were using has the capabilities to 
export your logbook in ADIF format all your contacts will be able to be imported into Ham Radio 
Deluxe Logbook.  We will get into that in just a minute. 

New we need to insert some information into the logbook.  In the main toolbar, click on the 
icon that is marked “Configuration”.  On the menu that opens, move down to the option “My 
Station” and click.  A screen will open that looks similar to the screen in the next illustration. 

 

You need to fill in the information in this screen.  This information is used in fields in your 
logbook and other places in the HRD suite of programs.  This data is saved into a location in the 
windows registry so it is available in all modules.  Once you fill in the information just close the 
window by clicking the red X in the upper right corner.  Your data sill be automatically saved. 
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Importing Previous Log Data 
Again, if this is the first time you have used HRD Logbook, you see your default (My Logbook) is 
empty.  If your previous logging program has the capabilities to export your log in ADIF format 
you can go to that log and export your data now. 

Once you have your previous log exported from your previous program, in the HRD Logbook 
Menu at the top of the screen, click on Logbook.  Move your curser down the list to Import and 
click then click on the ADIF 2 option.  The ADIF Import screen will now open. 

 

On this screen, to the right of the ADIF Filename field is a navigation box.  Click on that box and 
navigate to the location and filename of the ADIF file you saved from your previous logbook.  
Click on that filename and it should appear in the filename field of this window and the file will 
be imported.  You will see the next screen. 
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On the upper portion of the screen you will see information about the number of records 
imported.  If your logbook was empty it will NOT show any Duplicates or Warnings.  All tht is 
left to do now is click on the Save To Database button and all your contacts will be saved in the 
My Logbook database.  When you return to your logbook page you will see it is fully populated 
with your contacts. 
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Supported Databases 

Access Database 
For simplicity and small databases Microsoft Access is fine. Microsoft Access is used by default; 
you do not need to install other database products.  

Note: the Access database support is part of Windows, you do not need to install Access (part 
of Microsoft Office). If you are using Microsoft Access you can now skip the rest of this section. 

MySQL 
MySQL is the recommended alternative to Microsoft Access – excellent performance, the 
price is right, it’s very easy to install and configure and offers all the features expected from a 
full-blown database product. You can use MySQL on the same computer as Ham Radio Deluxe 
or over your network – Ham Radio Deluxe on your laptop, the MySQL database on either your 
web server or another computer at your home. On the computer where the database is located 
you must install:  
 MySQL Community Server (the MySQL database)  

 MySQL GUI Tools (database management program)  
 
On the computer where the logbook is installed you must install:  
 MySQL Connector/ODBC (ODBC support) 
 

Microsoft SQL Server Express 
The free version Microsoft SQL Server Express is limited to using one processor, 1 GB of 
memory and a 4 GB database. This is more than enough for any logbook application.  
From http://www.microsoft.com/express/sql/download/ download either:  
SQL Server 2008 Express with Tools, or SQL Server 2008 Express with Advanced Services.  

It is important that you have SQL Server Management Studio Basic - a visual database 
management tool for creating, editing and managing databases. Just like MySQL Microsoft SQL 
Server Express can be used over the network. 

Note: SQL Server uses .NET, PowerShell and Windows Installer.  You will be prompted to add 
these components if they are not installed on your computer. 
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Creating A New Access Database 

 

Creating a new Access database is quite simple.  In the Logbook display, click on Logbook, 
Databases, and then on Manager.   This brings up the Database Manager Window. 

 

As you can see, your default My Logbook is already configured and listed in the Database 
Manager.  Click on the ADD icon at the top of this screen. 
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You are now in the Database Definitions window.  In the Title field, enter a title for your 
logbook.  In this case we are using Digital Logbook.  Below the Title field you are asked to enter 
a description of your logbook. 

Under the description field you see a check box that says “Include in ‘worked status’ lookup”.  
Placing a check mark in the box indicates when entering a callsign in ANY log database, it will be 
checked to see if you have worked this station before and have it logged in another logbook. 

Once these are entered, click the OK button at the bottom of the screen.  That’s all there is to 
it.  You will be returned to the Database Manager and you will see your new logbook listed.  
You can now click OK to close the Database screen are return to the logbook display. 

To open your new logbook, click on the File menu, click on Open, and select the logbook you 
would like to open.  You can display more than one logbook at a time on the logbook display. 
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Creating A New MySQL Database 
Before we begin with this section we would like to give a special thanks to John (VK7XX) and 
Laurie (VK7ZE) for their efforts to compile the information on how to setup the MySQL 
Databases in Ham Radio Deluxe. 
 

The following applies to computers running Windows XP. Other versions of Windows and 
other operating systems may vary from what is shown here.    

In these examples you are going to need three packages.  They are as follows: 

mysql-5.5.13-win32.msi    -     MySQL Community Server 

mysql-workbench-gpl-5.2.34.1-win32.msi     -     MySQL Workbench 

mysql-connector-odbc.5.1.8-win32.msi     -     Connector / ODBC 

All three packages are available for download from http://www.mysql.com/downloads/ 

 

 

 

 

 
 

 

 

 

 

 

 

  

You will have to click ‘Next’ a few times, accepting the terms and conditions as you go. 

 

 

 

 

 

http://www.mysql.com/downloads/
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On this screen choose ‘Typical’  then Next and when it prompts, click Install.  

   

When you reach the two MySQL Enterprise screens, just click ‘Next’.  
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Make sure that there is a check mark in the “Launch the MySQL Configuration Wizard” box  
then click ‘Finish’.   

 

At the “Configuration Wizard” welcome screen, click ‘Next’.   
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Here we choose ‘Standard Configuration’ and click Next. 

 

Here we need to check “Install As Windows Service”, enter a service name, and put a check in 
the “Include Bin Directory in Windows PATH” then hit Next. 
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In this window place a check in Modify Security Settings.  You also need to enter a password 
that will be easy for you to remember.  Check the box for Enable root access from remote 
machines. 

IMPORTANT:  Tick the box ‘Enable root access from remote machines’. If you do not do this 
now, and at some future time you decide that you want to use your log on a network, and 
you have NOT ticked this box, you will have to do an uninstall, cleanup and reinstall.  Doing 
this now, may help to prevent a lot of work in the future and, even if you never set up a 
network, it will not cause any problems. 

To continue click Next. 
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Here we click  ‘Execute’ ……  sit back and relax while waiting a short time for the server instance 
to be installed. If all has gone well, you will see this next screen 

 

When the processing is complete click Finish. 
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The next part of MySQL we install is the Workbench.  Start the workbench installer, the first 
screen looks like the following illustration. 

 

 

 

 

 

 

 

 

 

 

 

Click ‘Next’,  then choose where you want it installed. (no screen shot required) However, I 
suggest you stay with the defaults and click ‘Next’ again and you will be presented with the 
following screen. 

 

 

 

 

 

 

 

 

 

For the Setup Type, select Complete and click Next. A "ready to install" screen displays. Click 
‘Install’. 
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When the Wizard has completed, check the check box next to Launch MySQL Workbench now 
and click Finish. 
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In a few moments the Workbench screen will appear followed shortly thereafter by the main 
Workbench screen. 

 

 

 

 

 

 

 

 

 

 

 

 

On this screen you se SQL Development - Data Modeling and Server Administration columns.  
Below SQL Development and highlighted in blue you will see  "Local instance MySQL User: root  
Host: localhost:3306"    Double click this blue line.  

I hope you remembered that password from before, because you need it for the next 
operation. 
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When the password prompt appears fill in your password and click ‘OK’.  You will be shown an 
additional screen with a 'test' database. 

 

    

 

 

 

 

 

 

 

 

 

In the column on the left, under “Actions” , click ‘Add Schema’.  A new Schema window will 
now open. 
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In the Name field enter a meaningful name for your logbook database and WRITE THIS DOWN 
as you will need the name in a later step. I also suggest that you choose a name that is in no 
way similar to any existing logs (databases) to avoid any later confusion.  Leave ‘Collation:’ as 
per the default and click ‘Apply’ 

A “Review” screen will open.  Click the ‘Apply’ button on this screen.  When that process 
concludes, click ‘Finish’. 

The “new_schema” window will now show (bottom of its screen) that ‘Changes have been 
applied’ . You can now click ‘Close’.  

You are also done with MySQL Workbench for now, so you can close it too. 

 Now it is time to run the connector installation .MSI package.  

 

Click Next on this page. 
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Select Typical and again, click next.  At the “Ready to Install” screen, click ‘Install’.   

 

Things happen rather quickly and in a very short time, a “Completed” screen will appear. Click 
Finish.  The installation of MySQL is now complete.  It’s time to  get things working within HRD 
Logbook  Open HRD and the HRD Logbook. 
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This next step is only required if you are going to convert your existing ‘Access’ database log file 
to the ‘MySQL’ database.     

If you are NOT converting an existing log, scroll down to  the next section, marked by two red 
stars (**)  

On the HRD Logbook tool bar, click the 'More' button and select ‘Export / ADIF 2’. 

 

 

In the ADIF Export window enter the full path and filename to save the ADI file to.  Next click 
the radio button for ADIF + Ham Radio Deluxe.  This tells the system to export not only the 
standard ADIF fields but also all the Ham Radio Deluxe fields in the Logbook Database.  Also 
make sure there is a tick in the ALL entries radio button.  Once you have this set up, click on 
Export. 
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Once the export is complete its back on the HRD Logbook screen, (you did open it earlier didn’t 
you?) locate the word ‘Tools’ and click, then click on ‘ODBC Administrator’.   A new window will 
open.    

 

Click the ‘System DSN’ tab then click the ‘Add…’ button. 

 

Scroll down to MySQL ODBC 5.1 Driver, click on it to select it and click ‘Finish’.   
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Remember that name you had to write down when you created the ‘new_schema’ ?? well, I 
suggest you use it now. Type that name in the ‘Data Source Name’ box and whatever you like in 
the ‘Description’ box. Leave TCP/IP server as it is then type in your username (most likely ‘root’) 
and the password. You know, the password I told you earlier not to forget… yep, that one.   
Now click on the ‘Database’ drop down arrow and select the database name you created 
arlier……  you should end up with a screen that looks something similar to the one above.  Click 
the ‘Test’ button.  

You should then see a small “Test Result” window with “Connection successful” thereon.  Close 
it by clicking ‘OK’.  

Click ‘OK’ on the “Data Source Configuration” screen and your “ODBC Administrator” screen 
should then look something like the image on the next page. 
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Click ‘OK’ to close this screen.  

Back to the HRD Logbook screen now, and across the top of its screen locate the word 
'Logbook'.  Click and scroll down to 'Databases' then ‘Manager’ and click.    

 

You can see that my current log is called  ALL_LOGS and is a Microsoft Access database type.   

Again, a reminder that your database(s) will have different names.      

The next step is to create the HRD Logbook MySQL database. Click on the ‘Add’ button.  A 
'Create Database Definition' window will appear.   
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In the title box, type in the any name you fancy and any description you like then click 
‘ADVANCED OPTIONS’.   Underneath the 'Create New Database' button you will see a 
dropdown box, click the down arrow to open this and scroll down to the name of the database 
you created earlier. Click on that name to highlight it then click ‘OK’. 

 

You will see that this database now appears in the list.  Click on the new database name to 
highlight it, then click the Move Up button as many times as required to move it to the top of 
the list.  The top most database in the list is the one that opens by default when HRDlog is 
started. 
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After you move your new database to the top of the list, click OK to close this window. 

 

 

 

 

 

 

 

 

 

 

In your logbook, click on the menu option Logbook, scroll down to databases and click the 
name of your new Logbook.  If all went well, a nice new EMPTY logbook will be displayed and at 
the bottom right of the logbook page you will see ‘MySQL’ instead of ‘Access’. 
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If you are performing a conversion, it is just a matter of now importing the ADI file you 
exported in the first step...    When import completes, click ‘Save to Database’, and you are 
done 
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Your new MySQL Logbook is all completed. 

Callsign Lookup 
Once your logbook is configured our next objective is setting up the automated callsign lookup.  
HRD offers many options for this including both free and subscription solutions. 

From your Logbook toolbar, click on the Configure icon and from that menu select Callsign 
Lookup.  You will see the following window. 
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On the right we have lookup options which are disabled.  On the right are the options we have 
enabled.  If for example you you have the HamCall CD and would like to use that to look up 
your entered callsigns, you would highlight it on the right side, press the < icon located between 
the windows and it will move to the left side of the display.   

If you would like to remove an activated option, highlight the option, click the > icon and the 
selection will be moved to the right window and be disabled. 

In our example, we have the QRZ XML subscription.  We want to use that as the first option in 
our lookup search.  If when we moved that option from the right side to the enabled left side it 
was on the bottom of the list, we click on the + icon to the right of the selected item to move it 
upward to the top of the display. 

In this case we are using QRZ as the first option for the lookup.  If the call is not found there, we 
check out logbook and see if we have worked that station before.  If it fails there our next 
option is it checks the country list to find the call. 
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The Logbook and Country List are automatically used on or off line, but to use a subscription 
service or a CD we need to tell HRD how to connect.  Click on the Lookup Options tab of the 
display at this time. 

 

If you are using the QRZ.com XML lookup service, you need to enter your Username and 
password in the area provided at the top of this section.  The same is true if you are using the 
HamCall XML service. 

Once you have this configured, to test to see if it’s working properly, enter a callsign in the TEST 
field in the lower right area of the window and hit the Lookup button.  If your QRZ or HamCall 
username and password is correct, you will see an XML display of the callsign you requested.  If 
you don’t see this, check your internet connection and be sure your username and password 
are correct. 

For CD call lookups, in the lower left side of the display is an area where you configure the path 
to the active CD.  If you have copied the CD off to the hard drive, then it would be the path to 
that data on the hard drive.  Just click the navigation box to the right of the proper field and 
navigate to the database location.  It will be entered in the field automatically. 

 



32 

LoTW and eQSL.cc Support 
HRD Logbook provides direct support for uploading and downloading from Logbook of The 
World and eQSL.cc.  These are the two major electronic QSL managers.  To use either of these 
services requires an account.  Setting up an account on either is FREE.  Sign into their websites 
and signup for a user account. 

Both services provide extensive Awards programs.  To participate in the LoTW Awards program 
requires you to become a paid member.  Once you have qualified for an award you must pay a 
fee for the award. 

eQSL.cc operates a little differently.  Once you set up an account, to take part in the awards 
program first requires you to become an “AG” (Authenticity Guaranteed) member.  This means 
you must provide eQSL with the proper paperwork to verify your Ham License status.  The next 
requirement is you need to make a “donation” to eQSL.  The donation can be as little as $5.00 a 
year to participate in the awards program.  Once these requirements are met and you qualify 
for an award, a certificate is issued, which you can download and print for FREE.  If you would 
rather have a nice engraved plaque, that would cost you additional. 

Setting Up eQSL 
Once you have established an account with eQSL.cc the setup in HRD Logbook to allow you to 
upload your contacts is very simple. 

Click on the Configuration icon then select the eQSL.cc option to open the configuration screen. 
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Enter your eQSL Username and Password in the fields provided.  If you use more than one 
account on eQSL, you need to enter the nickname of the account in the Nickname field. 

If you would like HRD Logbook to automatically upload each contact when it is logged, place a 
check mark in the Upload every time an entry is added to the logbook. 

When your finished click the OK button and your settings will be automatically saved. 

Uploading to eQSL.cc 
Uploading your contacts to eQSL is quite simple.  If you have checked the automatic upload 
option in the eQSL setup, each time you add a contact to your logbook it will automatically be 
uploaded to eQSL.cc. 

If you prefer to manually upload your contacts, that procedure is quite simple also. 
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To upload a group of contacts to eQSL, select the records in your logbook by highlighting the 
records you wish to upload.  You can do this by, for example, if you have a group in succession 
that you want to upload, highlight the first contact, press the SHIFT key then select the last 
contact and the group will be highlighted like in the above. 

If you have just selected contacts you want to upload, click on the first contact you want to 
upload to highlight it.  Press and hold the Ctrl key on your keyboard and click on each contact 
you would like to upload. 

Once you have selected your contacts, right-click on any highlighted contact to open the menu. 
Click on eQSL and then select Upload. 
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After selecting Upload, the above screen appears.  On this screen Press the OK button and your 
upload will automatically begin. 

When the upload has completed the screen will look like the one below. 
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You will see the number of records you uploaded and if there were any errors or warnings.  If 
the upload was successful click the Close button to exit the upload window.  That’s all there is 
to it. 

Setting Up LoTW 
Setting up to upload to LoTW is a little more involved.  Following the setup instructions to the 
letter is very important for the uploads to work properly. 

Logbook of the world uses software called TrustedQSL.  The software is free to download and 
use. Trusted QSL contains two programs TQSL Certificates and TQSL.  Trusted QSL works with 
MS Windows and there is a version for Mac OSX. 

If you are using anti-spyware programs you must configure your software to allow Trusted QSL 
to run.  

Download the software for Windows from the link below. 
http://www.arrl.org/files/file/LoTW%20Instructions/tqsl-113.zip 

Trusted QSL software is compatable with all MS supported Windows operating systems. 

** Windows Vista and Windows 7 (64 bit) users must download and save the TQSL 113.exe 
program then run the installation program as administrator. 

Requesting Your Certificate  
Logbook of The World uses private key – public key encryption.  The Trusted QSL software that 
you downloaded and installed on your computer contains two programs – Trusted QSL (TQSL) 
and Trusted QSL Certificates (TQSL CERT).  All certificates are managed in the TQSL CERT 
program.  

A certificate request (TQ5 file) is sent to ARRL and is answered with a TQ6 file.  When the TQ6 
file is loaded into TQSL CERT you will have your certificate, as indicated by the gold ribbon next 
to your call sign, which you will use to electronically sign your log files.     

The TQ5 and TQ6 files contain unique digital signatures and must match each other like two 
halves of a torn ticket.  Any previous certificate request is nullified when a new request is made 
so do not delete or alter any files after making a certificate request.  

Because the request and response must match the entire process must be completed from the 
same computer.  Once you have a complete certificate moving it to a new or second computer 
is only matter of a few clicks with your mouse. (see http://www.arrl.org/advanced-lotw )  

Requesting a certificate is not difficult.  It is simply a matter of entering some basic information 
about you and your call sign then saving a file – TQ5 and sending the file to LoTW.    

In this procedure we are going to request a certificate for your current call sign.    

The procedure below will guide you through each screen of the process.  Let’s begin.  

 

http://www.arrl.org/files/file/LoTW%20Instructions/tqsl-113.zip
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 After you have installed the Trusted QSL software you will have two program icons on your 
desktop.  

1.  Open the  TQSL CERT program by double clicking the icon on your  

  

  desktop.    

When opening the  TQSL CERT for the first time you will get a message  

saying that you have no certificates and asks if you would like to request a certificate.    

Click YES.   

•  If you inadvertently answered NO to the above question Select FILE >  NEW CERTIFICATE 
REQUEST… 

 

2.  This first box is informational and indicates that the issuer of the certificate is ARRL.  You do 
not have to do anything.  Click NEXT.  
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3.  Enter your  CURRENT CALL SIGN without any portable identifiers  

4.  Use the drop down menu to select the DXCC entity that matches your call and where 
you are operating.    

If you hold a KH6 or KL7 call sign and   

•  Your FCC address is Hawaii or Alaska then your DXCC entity will be Hawaii or Alaska.  

•  Your FCC address is in the continental United States then your DXCC entity will be United 
States of America.   

The QSO Date Range will determine which QSOs in your log can be uploaded to Logbook of The 
World.    

It is important that you enter correct information.  The QSO date range cannot be changed 
once the certificate is issued.  

5.  QSO  BEGIN date should be the date that this call sign was first  

issued to you.  If you are unsure of this date then use the earliest date in your log for QSOs 
using this call sign.  

•  Do not use today’s date.  

  

•   This may not necessarily be the date you were first licensed if you held another call prior to 
your current call sign.    

•  Do not use your birthday or any other date.  
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Currently active calls will not have a QSO END DATE.  Entering a QSO END DATE for a current 
call will limit the QSOs that can be uploaded for this call.  

 

   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 6. Enter your name and address.  For U.S licensees this must match your FCC address.  Click 
NEXT.  

7. Enter your e-mail address.  

•  Make sure that your e-mail provider allows attachments.  You will receive your TQ6 
certificate file, username and website password in an e-mail.  

 This next step is optional.  
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A password is recommended if you use a public computer or run LoTW/TQSL with a portable 
computer.  

If you choose to use a private key password please write it down so you do not forget it.  

If you lose or forget this password ARRL cannot help you.  

To fix a lost private key password, you will need to apply for a new certificate.    

 

  

  

  

  

  

 8.  Enter a password if you choose this option.  You may leave this blank for no password. 
(Recommended)  

 

   

  

  

  

 9. Be sure that your request is UNSIGNED.  Because this is your first certificate request your 
only choice should be UNSIGNED.  
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 You should now have a TQ5 file saved in your folder.   

  Windows Vista Users  

You must have compatibility files permissions checked.  If you see this folder click on it to allow 
compatibility files otherwise your will not be able to see the TQ5 file that you saved.    

 

  

  

  

  

  

  

 After clicking the compatibility files folder it will change to an icon that says BURN  
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 Please note that the upload is not automatic. You must continue to the next step to upload the 
TQ5 file you just saved or e-mail the TQ5 file to lotw-logs@arrl.org   

 

  

  

  

  

  

  

 

 

 

 

 

 

 

 

When done correctly your TQSL CERT window should look like this with a slashed red circle “Do 
Not Enter” sign, your call sign and your DXCC entity.  

It is important that you do not delete or move or rename the TQ5 file or delete the red slashed 
circle.  

  

 Option to upload the certificate request file (TQ5)   

 1. Go to the LoTW file upload webpage: https://p1k.arrl.org/lotw/upload  
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 2. Use the browse button to locate and select the TQ5 file that you created in the previous 
section. [your call sign].TQ5  

3. Upload the file.  

4. Sit back and wait for your postcard to arrive in the mail.  

If you are submitting a cert request for a non-US call sign, you will have to submit proof of 
license (a copy) and a copy of one other official document that shows your name, like a driver's 
license. See https://www.arrl.org/lotw/docreq for details.  Postcards and documents are used 
only during the initial account set up and are not required for once you have established your 
LoTW account.  

The above documentation was downloaded directly from the ARRL website and like many 
things on the ARRL site is somewhat outdated. 

The main difference is now instead of having to wait for them to send you a postcard with your 
certificate information on it, you will receive an e-mail.  Be sure you save the e-mail because it 
contains important information you will need when setting up HRD Logbook to upload and 
download from LoTW. 

Uploading to LoTW   
Once you have received your certification from LoTW, your ready to begin using the upload and 
download capabilities of HRD Logbook. 

To begin an upload, select records to be uploaded in the same way as you did for eQSL uploads.  
You can either highlight a group by clicking on the starting record, holding the shift key down 
and clicking on the last record for the group.  This highlights a block of records.  An alternate 
method is to select individual records by selecting the first record then hold the Ctrl key down 
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while clicking on the additional records.  The additional records do not have to be within a 
block. 

Next, right click on one of the highlighted records and select LoTW > Upload.  The following 
window will open. 

 

Verify that all information in this window is correct and press the Upload button.  Your records 
will be sent to the LoTW data server.   

One word of advice.  Once your logs are uploaded to LoTW, at times it takes up to a week or 
more for the entries to appear in the LoTW database and be validated.  If they don’t show up, 
just be patient.  They eventually will appear. 
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Downloading QSLs 

Downloading From eQSL 
Downloading from eQSL is just as simple as uploading.  Click Logbook on the log display menu 
bar.  Select eQSL on from the drop-down menu and select Download.  The following screen will 
open. 

 

1. Make sure all entries are displayed in the logbook window (in the Selection panel select All) 
before selecting this option. 

2. Enter your eQSL.cc Username, Nickname (if any) and Password. The Nickname is used if you 
have multiple eQSL.cc profiles. 

 

3. Select the Since date - only eQSL entries received on or after this date are returned. 

4. Press Download from eQSL.cc - the contents of the inbox are downloaded and displayed in 
the Downloaded eQSL Fields window. 
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5. Press Update Matching QSO's to update the eQSL fields in the entries in the current logbook 
that match any of the entries you have downloaded from eQSL.cc . 

When the logbook has been updated click Close to exit this window.  When you are back in 
your logbook screen, click on Refresh to be sure your downloads have been entered. 
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Downloading From LoTW 
To download from LoTW, click Logbook on the Logbook display.  From the drop-down menu 
select LoTW then select Download. 

 

Select the date where you would like your download to begin checking from.  Once the 
download is comlete the next screen will open. 
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On this screen click Save To Database and all records will be entered into your logbook.  When 
finished click Close and return to your logbook. 

Once back in the logbook, click Refresh and you will then see your verified downloads have 
been entered and verified in your logbook. 
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Creating Logbook Layouts 
The ability to create different logbook display layouts can be very helpful in many ways.  As an 
example, let’s say you want to just get an idea of the number of LoTW and eQSLs  you have sent 
and received.  You can create a display that shows the logbook like the display below. 

 

Notice the display above shows the LoTW Sent and LoTW Received along with the eQSL Sent 
and Received column.   

 

 

You could also create a layout showing the frequencies as a major part of the display.  You can 
create layouts including any or all of the 119 fields in the logbook database. 

Another very useful feature of being able to create the different layouts is in formatting a 
layout to create a printed hard copy of your logbook. 

To begin creating our logbook layout, click on the Logbook menu item.  Scroll down the drop-
down menu to the Layouts option and select Manager. 
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Your now at the Logbook Layout Manager window.  Let’s assume we would like to create a 
printout that contains the standard information such as call, name, QTH, etc, and the distance 
from our QTH in miles. 

To avoid starting completely from scratch, we will COPY one of the other layouts and modify it. 

To start, highlight the QSL layout and press the Copy command on the tool bar. 

The Layout Fields now opens.  To edit this we 
want to keep the QSO Date, Time, Call, Mode, 
Band and Name.  Highlight each of the fields 
we DO NOT want with your cursor and click on 
the < icon between the two columns.  This 
moves the unwanted item from the right 
column to the left.  Once we have ONLY the 
fields we want to keep in the right column, 
highlight the Name field.  Once you have this 
highlighted use the Up button to move this 
field up the list until it is under the Call field. 

Now we want to add some fields to the right 
column.  Scroll down the left column and add 
Distance by highlighting it and clicking the > 
icon.  Do the same with QTH, State, and 
Country. 
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Once you have all the fields in the right 
panel, arrange them the way you would 
like them to appear in the logbook by 
highlighting each field and moving it up 
or down into the position where you 
want it to be located. 

Now give your new layout a name.  Type 
over the current title and replace it with 
your chosen title.  Here we selected 
Distance Print as our title. 

When satisfied with the name and the 
layout click on the OK button at the 
bottom of the window to save your 
layout to the Layout Manager. 
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In the Layout Manager you can highlight any of the layout names and move them up or down in 
the list by clicking the Move Up or Move Down buttons on the toolbar.  Now, click OK on this 
screen to close it and return to the logbook. 

Once in your logbook click Logbook on the menu line, scroll down the drop-down menu to 
Layouts and select the Distance Print layout.  Your layout will immediately change from the 
default view to the view created in the Distance Print layout. 

Printing A Hard Copy 
To print a hard copy of your logbook, first decide how many records you would like to print.  
For example, lets say you want to print the last 30 days.  Highlight the first record with your 
cursor by clicking on it.  Next move down the log to a record 30 days earlier.  Hold the shift key 
down and click on that record.  This will highlight a block of records. 

Next click on the File menu and select 
Print.  This screen will open where you 
can create a nice cover page for your 
logbook printout.  Fill in the information 
like it is in the illustration. 

Make sure that where it says Print Range, 
near the bottom of the window, you 
have a check mark in the box to the right 
of Selected Only otherwise your 
complete log will be printed. 

Once you are finished on this page, click 
Continue and follow the prompts o select 
your printer and print the hard copy. 
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You should end up printing a nice cover page followed by your logbook entries formatted like 
the illustration above. 

The format we selected for the above printout was the Portrait format from the printers menu.  
If you require a wider printout you can select a Landscape format where you will be able to add 
more columns to the printout. 
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Menu Options 

File  
The File menu provides access to opening and closing logbook databases, print functions, 
Screen capture, restart and exiting of the logbook. 

View 
Provides access to various display layouts, toolbars, and the various floating panels available to 
be displayed on the logbook screen. 

Calendar 
The Calendar allows you to display a calendar and set reminders within the logbook display. 

Countries 
The Countries option gives you access to the Countries and Unique Call Sign Databases. 

Logbook 
Access to tools and options for the Logbook. 

Tools 
Allows you to run other modules in the HRD suite, access to database utilities,  access to the 
HRD Global Settings and the Logbook Configuration tools. 

Main Toolbar 

 

Main Toolbar 

The Main Toolbar contains icon links and displays for the main Logbook Display window.  The 
three largest displays on this toolbar are the Profile, where your callsign is displayed, the Clock 
display and the Frequency display.  All three are located on the right end of the toolbar. 

Beginning from the left end: 

Open:  Opens a database    Layout A:  Display Layout A 

Layout B:  Display Layout B    Rig Control:  Executes HRD Rig Control 

Digital Master:  Executes DM-780   Rotator:  Executes Rotor Control Module 

Tune Main:  Displays Main Tuning Bar  Tune Sub:  Displays the Sub Tuning Bar 

Manager:  Opens Database Manager   About:  About Logbook 

Home:  Opens browser to HRD Home Page. 
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Removing Main Toolbar 
For those who would like to gain a little real estate on the display the Main Toolbar can be 
removed by clicking on View > Toolbars and removing the check marks from those options they 
would rather not be displayed. 

This gives a cleaner appearance to the display. 

Logbook Icons 
Below is the Logbook Icon Toolbar 

 

 Add Log Entry (ALE)  Clicking this icon opens the ALE. 

 Contest  Opens the Contest Call Entry Screen 

 Delete  Highlight a logbook entry and click this icon deletes it from the logbook. 

  Modify  Highlight a logbook entry and click here to modify the entry. 

 Cut, Copy and Paste  Cut, Copy and Paste logbook entries. 

  Refresh  Refresh the logbook display 

  Width  Adjust column width to width of data 

  Layout  Define current layout.  Direct entry to Layout Editor. 

  Edit Selections  Define definitions for logbook search criteria. 

  QRZ.com  Highlight a log entry and click this icon opens the QRZ page for the entry. 
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  Awards Tracking  Opens the new Awards Tracking screens. 

  Backup  Click here to do a full backup of your logbook. 

  More   Opens a drop-down menu of logbook options. 

  Filter  Set filters for logbook display criteria to check Awards Tracking. 

 QSL  Toggles QSL status toolbar 

 Award  Toggles Award status toolbar 

  LoTW Upload/Download  Opens LoTW Upload/Download 
Dialogs. 
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Add Log Entry (ALE) 
This is the option that allows you to add contacts to your logbook.  Clicking on this icon opens 
the ALE window. 

 

Entering your contacts callsign in the Call field and pressing the TAB key initializes the call 
lookup sequences you have set up in the Lookup options settings.  Assuming you have an XML 
subscription to QRZ.com,  and have that listed first in your lookup options, Logbook will go to 
QRZ.com and pull the data about the entered callsign and populate the fields of the ALE. 
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In the lower portion of the ALE you see part of your logbook.  While you have a callsign in the 
Call field, clicking on the Partial or Exact icons will search your logbook and display any previous 
contacts you have had with this station.  

Clicking through the tabs just above the log window will show other information about this 
station gleaned from the XML data received from QRZ.com. 

When your QSO has completed and you are connected to a DX Cluster where you have the 
required permissions to post spots, clicking on the Add Spot button will add the information to 
the Cluster.  Clicking on the Add button, at the bottom of the screen, or pressing the F7 key on 
your keyboard will save the contact to your logbook. 

Looking at the Toolbar at the top of the ALE, there are several options available.  Clicking on 
Edit allows you to copy, cut, and paste information into the record.   

The Options menu allows you to adjust many of the displays on the ALE, such as how the start 
and end times are recorded, fonts used, along with other visual options. 

Tracking allows you to set the tracking of frequency and mode in the ALE. (You must be 
connected to your radio). 

Show Fields selects the fields to show in the log display in the lower part of the ALE. 

Show Tabs selects which tabs to show at the top of the log display of the ALE. 

Contest ALE 
Clicking Contest opens the Contest ALE. 

 

 

This ALE is set up specifically for contest use.  The easiest way to use this ALE is first to create a 
new log database dedicated to the contest.  In the Contest ALE, you select the contest from 
the drop-down menu.   
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To set the fields used for the contest, if there is a pre-saved selection for the contest it can be 
selected from the menu in the center of the display.  If there is no pre-saved display, you can 
create a form by adding the required fields from the list on the right of the display.  Just click 
the check box in front of the field you wish to add and it will automatically be added to the 
display. 

You can also select Dupe Checking by placing a check mark in the box to the left of the Dupe 
Check option. 

As the contest progresses, just enter the data in the fields for each contact and click the 
Add/Next icon or hit the F7 key on the keyboard to save the contact, clear the ALE and your 
ready for the next contact. 

Once the contest is over and you have submitted your logs and have received your credits, you 
can then export your contest log in ADIF with the HRD fields and import it into your main log 
database. 

Logbook Backups 

Automatic Backup Locations 
HRD Logbook has built-in capabilities to provide automatic or manual backups.  Clicking on 
Logbook then on the drop-down menu selecting Backups then Options opens the dialog where 
you can configure folders where your backups are stored.  The backup software creates two 
different type of backups.  One is an XML backup, which can be restored directly into a 
database or a compressed backup.  The compressed backups must be unzipped in order to 
restore them.   

You also have the option to create backups in TWO different locations at the same time.  This 
allows you to do a backup to a hard drive and also to an external storage device. 
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Clicking on the backup Options brings up the above screen.  The first option, Backup File 
creates a backup in the XML format.  Here you can select the navigation box to the right of the 
field and navigate to the location where you would like to have this backup created. 

The second option is the Archives.  Two different archives are created.  In the first option a 
single compressed backup is made from the current logbook.  As you can see, you can select 
two different locations for storing this archive.   

The second archive option ADDS the current backup to a compressed file containing ALL 
backups made.  Again you can select two different locations to store this compressed file. 

On the lower left of the screen you also have options on how often you would like the 
automatic backup done.  You can select having the backup done each time you open or close 
the program, after X number of entries are added to the log.  You can also backup the log on a 
timed basis by selecting the backup interval from the drop-down selection box. 

Manual Backups 
Once you have configured your backup locations for the automatic backups, you can also do 
manual backups.  Just select Logbook > Backups > Backup  and the backup will be made and 
stored in the locations configured for the Automatic backups. 
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Restoring Backups 
To restore a logbook, just click Logbook > Backups > Restore and navigate to the location of 
your latest XML backup.  Select the file and follow the prompts to read the XML file then save it 
to the database. 

Export/Import Logs 
HRD Logbook can export logbooks in several different formats.  There are two ADIF formats 
available (ADIF 2 and ADIF (ADX)) along with the Cabrillo format which is requested by many 
contest organizers for log submission.  You can also export the log in the Microsoft Excel (XML) 
format. 

Exporting an ADIF File 
Selecting Logbook > Export > ADIF 2 from the menu opens the export dialog. 

 

This dialog allows you to enter the ADIF path and filename in the top field.  You can also select 
the fields you wish to export.  For example, if you are exporting the logbook to be uploaded to 
an on-line logbook or imported into another computerized logging program you want to select 
ADIF Only.  This exports only the fields based on the AIDF standard. 

If you log is going to be imported into another HRD Logbook program, select the second option, 
ADIF + Ham Radio Deluxe.  This option exports all the ADIF fields plus those fields which are 
proprietary to HRD. 

If you are uploading to eQSL, you want to select that option since HRD will only export the fields 
used by eQSL. 

You can also select whether you would like to export the entire logbook or just selected 
records.  You can select a block of records by clicking on the first record to be exported, holding 
the shift key down and clicking on the last record. 
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You can also select a group of individual records by holding the Ctrl key and clicking on each 
record you would like to export. 

Exporting a Cabrillo File 
The Cabrillo export is used by most contest organizers for log checking.  Clicking on this export 
option brings up the following window 

 

In this form you fill in the path and filename for the export.  You also select and fill in the other 
required contest information.  You also select the export range, whether selected records or all 
records in the log.  When all information is ready, click Export. 

Exporting an Excel XML file 
To export an Excel XML file, clicking on the Excel option in the Export options opens the 
following window. 
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In this dialog, enter the path and filename of the XML file.  Select the export range, whether 
selected records or all records.  When ready to export, click the Export button. 

Importing Logs 
Many logbook programs have the capabilities to export their logbooks in ADIF format.  The only 
problem is the ADIF standard is not really that standard.  Some programs will also include 
proprietary fields in the ADIF file. 

Normally though, basic information such as call, qso dates, QTH, etc, are standard.  When 
importing an ADIF log from another logging program into HRD Logbook, you can expect some 
errors.  As long as the basic information is imported is the important thing.  The rest can be 
modified later. 

To import an ADIF file, click Logbook > Import > ADIF 2 and the following window opens. 
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First, select the options you would like.  If you have records in your logbook, do you want the 
import to Overwrite, Ignore, or Add a duplicate record.  Also you would want the import to 
compute the DXCC from the callsign if no DXCC is in the record.  You can also select to update 
the country name and continent from the DXCC value and lastly, insert your station 
information. 

Next, select the path and filename of the ADI file you are importing.  Once the import has 
completed the status of the import is shown in the upper right side of the import window. 

If all appears good, click on the Save To Database button to save the imported records to your 
logbook. 
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Bulk Editor 
The bulk editor is an option that allows you to edit and change data in columns over a range of 
records.  Selecting one record,  a block of records or all records in the logbook allows the bulk 
editor to become active by clicking on Logbook > Bulk Editor > and selecting the option you 
would like to change. 

Clicking on the Bulk Editor brings editor window. 

Backup:  Before you start - take a backup! 

Bulk Editor 

The bulk editor is used to change one or more 
fields in the QSOs selected in the logbook 
window. All you do is simply add the fields to be 
changed, then press OK. The logbook window is 
refreshed when the Bulk Editor window is closed. 

Adding Fields 

Now select the Fields tab and add the fields to be 
changed. For example you would like to edit the 
distance and heading.  When updating the 
distance and heading, select latitude and 

longitude which are closest to the other station's real location.  Selections can be made from 
QSO data - the values currently in the logbook database,  from country - the values in the 
Country database, usually (but not always) the location of the capital city, from locator - use the 
other station's locator (if any). 

If values are not available for the current select the entry is flagged as invalid and is not 
updated. 

 

HRDLog.net 
HRDLog.net is an on-line logbook service.  This is a 3rd party option not owned or operated by 
HRD Software LLC. 

The first step is to log on the HRDLog.net website and establish a FREE account.  Once your 
account is established you need to request an upload code to enable you to upload your 
logbooks. 

When you receive your upload code, in the HRD Logbook screen on your computer, click on 
TOOLS > CONFIGURE > HRDLog.net and the following screen will appear. 
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In this screen you enter your Username and the upload code you received via e-mail from 
HRDLog.net. 

Uploading your contacts is very easy.  The first time you will probably want to upload your 
entire log.  Right click anywhere on the logbook and click SELECT ALL.  This will highlight all the 
entries in your logbook.  Next, right click on any record and select HRDLog.net from the context 
menu and select upload.  That’s all there is to it.  Your entire log will be uploaded to 
HRDLog.net. 

Once you have your initial logbook uploaded you can either update from time to time by 
uploading contacts you have made since your last upload, or you can return to the 
configuration screen shown above and place a check mark in the box that says “Upload every 
time a new contact is added”. 

The second option on the configuration screen is “ON AIR”.  This is a little service from 
HRDLog.net that when activated indicates on their website when you are On The Air by sending 
your current frequency and rig to a display on their site. 
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DX Cluster 
The DX Cluster is a part of Ham Radio Deluxe that all DXers and Award chasers are familiar with. 

The DX Cluster allows you to monitor the activity on single band or the entire amateur radio 
spectrum in an attempt to hear those callsigns, countries or special operations needed for 
awards. 

HRD’s version 6 DX Cluster is one area that has gone through almost a complete re-write from 
its original version in V5.x. 

New features that have been added are Work Status Indicators (WSI).  These indicators help 
you see at a glance whether a station has been worked on a certain Country or Station has been 
worked on a particular band or in a certain mode or both. 

Also new are indicators of whether a spotted station participates in LoTW or eQSL.  Logbook 
now downloads a database which contain LoTW member callsigns.  It also downloads a 
database of eQSL (Authenticity Guaranteed) users.  When a spot appears in the cluster, these 
databases are checked and an indicator is shown in the display as to which group the spot is a 
member of. 

These options, along with many others are configured from the DX Cluster Options screen. 

With the DX Cluster displayed, click Options on the toolbar. 
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This is the DX Cluster Options screen.  From here you can add or remove clusters available,  
change the appearance and layout of the cluster on the HRD display,  set spot filters and alarms 
and much more. 

To include the Work Status Indicators in the Cluster display, select the Layout tab where you 
can add or remove options to be displayed. 

To set the LoTW and eQSL membership objects, scroll across the top tabs to the QSL 
Membership tab.  From there you can configure when and how to download the database 
updates and whether you want this option enabled or disabled. 

They say a picture is worth 1000 words.  Sometimes a video is worth even more. 

Mike Carper (WA9PIE) co-owner and avid DXer was very instrumental in developing the WSI 
system used in the DX Cluster.  He produced a very good video that explains the WSI and the 
use in the clusters.  That video is on the HRD YouTube channel at: 

 http://www.youtube.com/watch?v=-Wk4BSrHHpw 

Another nice feature included in HRD’s DX Cluster is the ability to use VE7CC’s CC User program 
to feed DX spots to Ham Radio Deluxe. 

 

http://www.youtube.com/watch?v=-Wk4BSrHHpw
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Jim Kehler (KH2D) wrote a very informative paper on interfacing CC User to HRD’s DX Cluster.  
The following is that paper. 

Ham Radio Deluxe and The DX Cluster 
This is an abbreviated introduction into how use VE7CC’s CC User program to feed DX 
spots to Ham Radio Deluxe. But first an explanation of why you might want to do that is in 
order. 
 
Ham Radio Deluxe is the “Swiss Army Knife” of logging software. It does a lot of stuff. It’s 
a large, complicated suite of programs that combines logging, radio control, DX cluster 
monitoring, digital modes, rotor control, satellite tracking, and a few other features into the 
ham shack do all software package. It’s not your Grandma’s logging program. 
 
Unfortunately, many ham shack computers are almost as old as your Grandma. While the 
developers of HRD are doing as much as possible to enhance the performance of 
the suite, regardless of the platform on which it’s running, it behooves the user to do as 
much as possible to increase the performance on his or her individual computer. Not 
everyone has an i7 processor with fifty gigabytes of ram available for the ham shack. 
 
The DX Cluster has, over the 25 or so years since its inception, evolved into a large, 
bloated, overloaded mess. Skimmer spots have added another 80 percent to the bloat. 
Gone are the days when we sat in the shack waiting for the red light on the TNC that 
would light up when a DX spot from our local cluster was being delivered by the local 
cluster node. 
 
It’s not uncommon, on a contest weekend, to see well over a hundred spots a minute, all 
of which are circulated world wide. 
 
Yes, HRD has spot filters in the cluster interface. But it’s already very busy figuring 
out the country, zones, beam headings, distances, and checking your logs for 
needed/worked/confirmed status for each cluster spot that it receives. So anything that can 
be done to lessen the load on the logging program is beneficial to overall performance of 
the suite. There is no sense in processing DX spots that the user doesn’t want to see. 
 
CC User is an easy and efficient way of filtering DX spots before they reach HRD. The 
following is a brief tutorial to help get you up and running. 
 
73, 
Jim 
KH2
D 
 
 

Using CC User as a DX Spot Pre-filter for HRD 
 
Lee, VE7CC, has written an excellent tool which can be used to configure filter settings 
on a DX cluster node. It also provides many options for filtering DX spots and a GUI 
which makes filter configuring much easier. 
 
The program also works as a “server”; connect the program to your favorite cluster node 
and then you can connect HRD or any other software that is Telnet capable to CC User and 
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receive DX spots as configured from your favorite cluster node. It  will also  accept 
multiple connections from computers on your LAN. 
 
Download the 
program here: 
 
http://www.ve
7cc.net/ 
 

This covers only the basic setup/use of CC User here; more information is available on 
VE7CC’s web site. 
 
After you have installed the program, configure these basic items: 
 
From the menu, select Configuration/User Information. Enter appropriate data: 
 

 
 
 
From the menu, select Configuration/Cluster (Telnet). Select a node, or add one: 
 

 

 

http://www.ve7cc.net/
http://www.ve7cc.net/
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From the menu, select Configuration, then Ports/Logging Program. Configure the 
logging program connection as shown: 
 

 
 
 
 
That’s all you need to get started. Click the CONNECT button on the main screen to 
connect to the cluster node that you have selected. 
 
You also need to configure the connection in HRD. HRD will be connecting to CC User, 
not to a cluster node. 
 
In HRD Logbook, in the DX Cluster window click OPTIONS. In the Options pane, 
click the CONNECTION tab, and then the ADD button. Configure the connection as 
shown (Title of your choice): 
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In HRD’s cluster window, select the node you have configured (in this case “CC User”) and 
click the 
Connect button. HRD should now be receiving DX spots from 
CC User. 
 

Basic DX Spot Filtering 
 

 
Filters in CC User can be configured two ways – PASS or REJECT. So you can chose, for 
example, any number of countries, bands, frequency ranges, etc. to either PASS or 
REJECT. 
 
When you change filters on the CC User screen, you will be reminded that you need to 
click the “Tell Cluster” button – this sends the changes you have made to the cluster node. 
 
Filtering by Band – I use the band filters on a regular basis. No need in seeing spots for 
160 meters because I don’t have a 160 meter antenna. In this example, on the BAND tab 
in CC User, I have configured filters to PASS spots on the lower portions of 40 and 20 
meters, and to reject spots on any other band. (Green = PASS, Red = REJECT). 
 
If I wanted to see if 6 meters was open, I simply uncheck the frequency ranges I want to 
see on 6 meters, and then click the “Tell Cluster” button to notify the connected node that 
I want to change my filter settings. 
 
 

 
 
 
Filtering By Country – CC User will set filtering in your cluster node based on country – 
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either the country of the call in the DX spot or the country of the station that sent the spot. 
For example, you could display spots of only stations in the United States, or only spots 
that were sent by stations in the United States. 
 
Using the form displayed when clicking the COUNTRY tab, select Filter Type (Spotter 
Country or DX Country), Pass or Reject, and then select the countries you want to 
pass or reject using the Continent selection. Basically the same system as the example 
given for bands above. 
 
Filtering by LOTW Users – CC User will allow you to filter spots based on who is using the 
ARRL’s LOTW system. Since the ARRL will not release a list of users, LOTW users are 
determined by using data bases complied by users who have submitted lists of calls to 
those data bases. 
 
Using the Set menu, configure LOTW as shown in the graphic; with this configuration, 
only spots where the DX station has been determined to be a LOTW user will be passed to 
HRD. 
 
 

 
 
 
Skimmer Spots – DX spots created by robot “skimmers” (software listening for 
someone calling CQ) are also available on certain cluster nodes. I think the concept was 
originally intended for the Reverse Beacon Network (propagation checking), but migrated 
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to the DX cluster. 
 
Spots generated by a robot skimmer are indicated on the DX cluster with a “-#” following 
the call of the spotter; so if you see a spot from EI6BT-#, it’s from a robot, not from a live 
person. 
 
To turn skimmer spots on and off from your connected cluster node (depending on 
whether skimmer spots are available), use the cluster commands: 
 
Set/skimmer 
Set/noskimmer 
 
So…. 

KH2D calls CQ on 40 meter CW. He can see, by monitoring the Reverse Beacon Network 
web site: 
 
http://www.reversebeacon.net/main.php 
 

that he was spotted by 32 different skimmers around the world, which gives him an 
immediate picture of propagation. Pretty kewl. 
 
Since 32 skimmers heard KH2D calling CQ, and since each one of those skimmer 
reports was passed on to the DX cluster, KH2D gets spotted 32 times, on the same 
frequency, on the DX Cluster. Not very kewl. 
 
Skimmer spots add an enormous amount of overhead to the already overloaded DX 
cluster. 
 
They are useful, from the standpoint that by the time a DX station is almost finished 
calling CQ, you can be on frequency and ready to pounce on him, but who needs to see 
the same spot 32 times. 
 
CC User takes much of the pain out of skimmer spots by filtering the dupes, so even when 
KH2D is heard and spotted by 32 skimmers, you will only see the spot one time. 
 
From the Set menu, make sure “Show Skimmer Dupes” is not 
checked. 
 

 

http://www.reversebeacon.net/main.php
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To appreciate the volume that skimmer spots have added to the DX cluster, you might 
want to check that option some weekend during a major contest. Just for fun….. 
 
Anyway, that should cover the basics. Hopefully you will find the 

above useful.  

73, Jim KH2D 
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Awards Tracking 
Long time users of Ham Radio Deluxe who have upgraded to version 6.0 will notice the old 
Legacy Awards section is completely missing from Logbook.  The new Awards Tracking is a 
completely new innovative tracking program.  The new Awards Tracking software tracks both 
ARRL awards and the eQSL awards at present time.  More awards can be defined by the user. 

 

In Version 5.0 there were only 6 awards programs available for tracking.  In Version 6.0, 15 
awards programs are represented with a total of over 200 individual awards within those 
programs and over 100 endorsements (not including accumulation endorsements for mixed, 
band, or mode credits). 

Again, Mike Carper (WA9PIE) was instrumental in the development and implementation of this 
new Awards Tracking software.  

It would take 50 pages of type to explain how this tracking software operates, so it’s best letting 
you hear about it straight from “the horses’ mouth”. 

Mike has produced another great video explaining the Awards Tracking.  Please watch the video 
to learn more.  It’s located on the YouTube, Ham Radio Deluxe Channel at: 

http://www.youtube.com/watch?v=rb16GSvBEms 

   

 

 

 

 

http://www.youtube.com/watch?v=rb16GSvBEms
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Label Printing 
One of the most requested features for version 6.0 was the ability to print QSL labels.  At the 
time this manual was written, the label printing function was a “work in progress”. 

To access the label printing utility, highlight a single QSO or a block of QSOs in your logbook.  
Right click and select Labels from the context menu. 

 

The Label printing utility has the capability of printing either QSL labels or address labels.  This is 
selected by ticking your choice in the Label Type box.   

You can also print a range of labels by selecting the Selected or the All options. 

In the above illustration we have selected to print QSL labels.  On the top left is a list of fields 
available to print on the label.  Select the field on the left and press the > icon between the 
windows to move your option into the right window.  Proceed until you have all the fields you 
wish to appear on your label. 

Next, in the top right window, select the label you are using.  The label selected will be shown 
in the preview area in the lower right side of the screen. 

Since all printers print slightly differently, even same model of printers print slightly differently 
and feed paper a little differently, it may be necessary to run a few test labels to make any 
necessary adjustments.   

Once your adjustments are made and you are satisfied with the alignment of the print on the 
labels, you are good to go. 
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